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FILES CONTAINED IN THE SYSTEM DISK

The system disk contains the following files.

RSS-Stage
151
3}
STHES
This application was designed to be used in the Stationary Mode. It allows you to localize upto16
sound sources (a total of 32 channels) in three-dimensional space.
RSS-FX

This application was designed to be used in the Flying Mode. It allows you to localize up to 4 sound
sources (a total of 4 channels) within three-dimensional space, and move them in real time.

Roland Serial MIDI Driver



SETUP

O

(1) Recommended Platform

Computer IBM computers or 100% compatible computers

CPU/Clock i4865X/25 MHz or faster (i486DX/33 MHz or faster is recommended)
Monitor EGA or VGA

Windows Microsoft Windows Version 3.1 (in 386 enhanced mode)

Memory (RAM) More than 5.6 MB (8 MB or more is recommended)
Hard Disk 2 MB of free space

* Note: Free space on the hard disk refers to the amount remaining after Windows has been
installed.

(2) Connection Cable

Computer cable: Roland RSC-15AT (Optional)

3) Other

Ifyou already have some other device connected to the RS-232C connector, you will need to detach
that device first.

* The formerly used application and driver should be removed from the system as well.



INSTALLATION

1. Before Installing

First of all, before starting up any applications, you need to install the driver so the RS5-10 can be
used. After that, you may install the'RSS-Stage and RSS-FX programs.

* The driver supplied with this package complies with the recommendations set forth by Microsoft
Corporation’s Multimedia Extensions (MME).

* The RSS-Stage and RSS-FX applications on the “Windows Version Application Disk” cannot be
run from floppy disk. Always install them on your hard disk first. You will need to have 2 MB
or more of available storage space for each application. (After Windows and all related files have
been installed on the hard disk.)

2. Installing the Driver

The following explains the procedure you should carry out to install the supplied driver onto your
hard disk. i

1 Start up Windows.
2 Open the “Control Panel” icon in the “Main” group of the “Program Manager.”
3 Choose “Drivers” in the “Control Panel.”

The “Drivers” dialogue box appears. All drivers that are currently installed are displayed. The
supplied driver needs to be added to this list.

If any of the drivers shown below are already in the list of installed drivers, they should be removed
first. Refer to the manual for Windows for instructions on how to remove them.

Roland LAPC1, Roland MPU401 MIDI Driver, Roland Super MPU MIDI Driver

If a Serial MIDI driver by a company other than Roland is already installed, you may not be able
to obtain satisfactory operations if you install the Roland Serial MIDI driver. Such situations can be
dealt with as follows.

<Solution 1> When the Driver has a Disable Switch

If the setup dialogue box for the Serial MIDI driver designed by another company has a selection
which allows you disable the driver, use the switch to turn off that driver, then install the Roland
Serial MIDI driver. ‘

<Solution 2> When the Driver Does Not Have a Disable Switch

if the non-Roland Serial MIDI driver does not allow you switch it off from its setup dialogue box,
you will need to remove it before installing the Roland Serial MIDI driver. Refer to the manual for
Windows for instructions on how to remove it.
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Click “Add.”
The “Add"” dialogue box will appear, showing the List of Drivers.

Select “Unlisted or Updated Driver” and click [OK].
The “Install Driver” dialogue box is displayed.

Insert the “RSS Applications for Windows” disk in drive A.
Type “A:\" into the text box.

Click [OK].
The “Add Unlisted or Updated Driver” dialogue box is displayed.

Select “Roland Serial MID! Driver” and click [OK].
The “Roland Serial MIDI Driver Setting Dialog” dialogue box is displayed.

Make the necessary settings for the driver.
Select the COM port (serial port) to which the sound generator is connected, and click on it.
Set the serial port switch on the rear of the RSS-10 to “PC-1/PC-2.”

* Always switch OFF the power on the RSS-10 before changing this switch.

Click “OK” once you have finished making the driver settings.
The “System Setting Change” dialogue box will appear.

To activate the driver that was just installed, click “Restart Now” to start up Windows again.

This completes the driver installation.

* When using the serial port for input, you could encounter situations whereby the processing
speed of the computer is insufficient, resulting in the unreliable transfer of data. Should this
occur, we recommend that you switch to using a MIDI interface such as the S-MPU MIDI
Interface. When using a MIDI interface, use the driver supplied with the MIDI interface.



3. Installing RSS-FX
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Start up Windows.

Insert the “RSS Applications for Windows” disk in drive A.
Select “Run” from the “File” menu of “Program Manager.”
Type “A:SETUP” into the text box.

Click [OK].
The RSS-FX installer program starts, and the RSS-FX Installation screen will appear.

The destination drive and directory name will be displayed. If this is where you wish to install the
software, click [OK]. Otherwise, change to the desired drive or directory first.

When the dialogue box appears, check that the “RSS Applications for Windows” disk is in drive
A, then click {OK].

A dialogue box will appear, asking you to input the “Serial Number,” “Name”, and “Favorite
Music.” After you have completed this, click [OK].

* You must type in something for all items.
* The serial number is the number that is stamped on the sticker affixed to the exterior of the box.
installation begins.

A dialogue box appears once the installation has been completed. Click “Yes” if you wish to read
the “Readme” file.

* The most up-to-date information could not be included in the manual, so it was placed in the
“Readme” file — please make sure to read it.

The “Readme” File is displayed. After you have finished reading it, select “Exit” from the “File”
menu to close it.

A new group named “RSS-FX for Windows” is created in “Program Manager,”
and an application icon will appear.



4. Settings for the MIDI port

Next, you need to make settings for the MIDI port so the RSS-10 can be used with “RSS-FX for
Windows,”

1 Start “RSS-FX for Windows” by double-clicking the “RSS-FX” application icon.

2 Select “Roland Serial MIDI” for “MIDI Interface” under the “File” menu in “RSS-FX for Windows.”



USING THE APPLICATION

Y

The Windows version Control Software includes the RSS-Stage and RSS-FX applications, which you can select depending
on your purpose. This document explains how to use RSS-FX. For detailed instructions on the use of RSS-Stage, read the
owner’s manual for RSS-Stage (Windows version Control Software).
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BASIC OPERATION OF RSS FX

e

R

To quickly get to where you can start moving sounds around, follow these basic steps:

1.

N o o

®

9.

Connect the computer, MIDI interface, RSS-10, and sound source (CD player, tape recorder, MIDI
sound module, etc.). For-a detailed explanation, refer to the RSS-10 owner’s manual,

The RSS-10 can be connected directly to the computer’s Serial Port without using a MIDl interface.
To synchronize the sound with the picture on video equipment, you will need a MIDl interface that
includes a time code interface.

Set the Device D on the RSS-10.

Start RSS-FX.

Make the settings which aresappropriate for how you are going to be using the system.
Set the Device IDs to correspond to those used by each RSS-10.

Play the sound source.
Set the Link Button [Link] (2-21) in the Movement Window (2-1) to ON.

Select the Drawing Pen (2-14) in the Movement Window (2-1), then draw the movement curve by
dragging the mouse.

Click the Temporary Play Button (12-3) in the Sequence Window (12-1), and the input sound will
move along with the specified movement curve.

To leave this mode, click the Stop Button (12-4).

11
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STARTING THE APPLICATION

e R

To start RSS-FX, double-click the RSS-FX icon. When you use RSS-FX for the first time, select [New] (Control+N) from the
File Menu. Then, the following five Windows will open.
If you already have an RSS-FX file, RSS-FX will start and the windows will open simply by double-clicking the file.

RSS-FX

Edt_Select Modify Display Sialus Window Help

MIDI-Note

Sequence

dit Select

13



When you use RSS-FX for the first time, you need to set the environment according to the requirement of the RSS System
you use. To set the environment, select [Configuration] from the File Menu. The following Configuration Window will
open, allowing you to view the current environment.

* Changing the settings in the Configuration Window will automatically update the status of corresponding device driver.

1-21-3 1-4 1-5 1-6 1-7

~FX Cenfiguration

1-1 Configuration Window

1-2 Check Boxes

1-3 Device ID

Check the box for each device (RSS-10) to be used in the RSS System.

A Device ID is a number that distinguishes one RSS-10 from others. Assign a different number to
each RSS-10.

1-4 Output Mode

1-5 Delay Mode

14

1-4-1 S.P. Angle (Speaker Angle)
This is the Output Mode for each device. To change the settings, click the Output Mode of the
relevant device, then select the Output Mode from the Sub Menu.

Speakers: This mode allows you to change to the sound that is suitable for playing through speakers.
The number represents the angle of the speakers (open angle from the center position).

Phones: This mode allows you to change to the sound that is suitable for playing through
headphones.

Binaural: This mode outputs the sound in Binaural.

* For a detailed explanation about the Output Mode, refer to the Owner’s Manual for the RSS-
10.

This shows the Delay Mode for each device. To change the settings, click the Delay Mode of the
relevant device, then select the Delay Mode from the Sub Menu.

REL (Relative): The Doppler effect cannot be created even by moving the sound source. Delay
effect will not be applied to the direct sound.

ABS (Absolute): The Doppler effect is created when the sound source is moved. Delay effect will
' be applied depending on the distance to the sound source.



1-6 Polarity

This is the polarity for each device. To change the polarities, click this, then select P or N from the
Sub Menu.

P (Positive):  Positive Polarity (Not highlighted)
N (Negative): Negative Polarity (Highlighted)

1-7 MIDI Channel

This allows you to set the MIDI channel on which the Note messages of the Phrase (S-1) attached
to each track will be sent. If, however, the MIDI channel has been specified for each item of data,
that will take priority and the MIDI channel you set here will be ignored.

1-8 Exit

Click this to close the Configuration Window.

15



2. LOCALIZATION IN THE 3D SPACE

SR

This allows you to draw the movement curve of the sound source for each device in the three-dimensional space.

2-1
|

(e RSS-FX [s]2]
I fle Edit Select Modify Display Status Window Help

2-12 2-7

2-1 Movement Window
The Movement Window can be used to check the movement curve of the sound source or change
it. The movement curve of a sound source can be observed from three directions (up, back, left).

2-2 Head Position

The Head Position is the head shaped graphic located about the middle of the Movement Window.
The RSS System simulates the sound audible at the Head Position in the three-dimensional space.

2-3 Movement
This point indicates the position of the sound source at a certain moment. We call this point an
EVENT. When an Event is selected, it is shown as “0.” When it is not selected, “X” is shown.

2-4 Current Position
This shows the current position. When you draw a new movement using the Drawing Pen (2-14),
anew movement is inserted here. When you paste what you have copied, the data is also inserted
here. In both cases, the Event that was selected before the insertion will be overwritten and erased.

2-5 Room Size
This square frame shows the room size that may be expected according to the reverberation to be
added. The lines should not be taken as being the exact location of walls, however. The Room Size
can be selected with Room Size (4-2).

16
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2-6 Zoom in
Click this to enlarge a certain part in the display. The clicked point will be enlarged.

2-7 Home Position
Click this button to return the listening point to the original size.

2-8 Zoomin
Click this button to enlarge the middle part of the display.

2-9 Zoom Out
Click this button to reduce the middle part of the display.

2-10 Top View
' Click the Top View button and highlight it to watch the movement curve of the sound source from
the upper direction.

2-11 Back View
Click the Back View button and highlight it to watch the movement of the sound source from the
rear. The horizontal line shown in the display represents the floor surface.

2-12 Left View

Click the Left View button and highlight it to watch the movement of the sound source from the left.
The upper part of the display represents the front. The vertical line shown in the display represents
the floor surface.

17



2-13 Selection

| RSS-FX [=1a
e Edit Select Modi isplay Status  Window Hel,

2-13
2-14
2-15
2-16

2-17
2-18
2-19
2-20

2-21
2-22

2-23 2-24

The dotted curve will appear if you drag the mouse while holding its button down. Enclose the
Events with a rectangle and release the button, and the enclosed Events will be selected. if you
specify the new range, the current selection will be automatically canceled. If you specify a new
range while holding the [SHIFT] key down, both the new and the current range will be selected.
To cancel what you have specified, use Select (7-2) in the Menu Bar. if you click on the Event while
holding the [OPTION] key down, the whole range from the current position to the clicked position
will be added as the newly selected range.

2-14 Drawing Pen

2-15 Fitting

By dragging the mouse while holding its button down, you can input the movement curve of the
sound source. Data will be inserted after the current position. This position is automatically written
into memory in approximately every 50 ms, even without moving the mouse. Up to 1 minute data
can be written to one movement. Any data that exceeds 1 minute will be automatically erased and
never be restored.

This allows you to pull the current position and edit it using the mouse. Click any point you like.
This applies to the Event currently selected, so put the current position to the Event currently
selected.

2-16 Rotate, Move and Magnify

18

Point to the tag with the mouse and rotate it, and the selected Event will be rotated at the Listening
Point. It can also be enlarged or reduced at the same time. If you do this while holding the SHIFT
key down, itwill be only rotated. If you move the mouse while holding its button down at the place
other than the tag, the selected Event can be shifted horizontally.
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2-17 Move Current Position
Clicking this button will move back the current position. If you keep pressing it, the current position
will move as quickly as when in playing. Double-click it to return to the top.

2-18 Move Current Position :
Clicking this button will advance the current position. If you keep pressing it, the current position
will move as quickly as when in playing. Double-click it to move to the end.

2-19 Movement Page Button
This button selects aMovement Page. There are 5 pages from 0-4. To advance a page, click the right
half of the button. To back up a page, click the left half of the button.

2-20 Movement Number Button
This button selects a Movement. There are 10 Movements from 0-9, and you can make 50
Movements with five pages.

2-21 Link Button '
You can have the same settings be applied to a Temporary Phrase (12-2) in the Sequence window
by selecting a Movement while this button is kept depressed.

2-22 MIDI

If you have clicked this button and highlighted the indication, Note messages of number 0 on 0 page
of “MIDI-NOTES” will be transmitted each time the current position is moved. That is, the position
of the sound source can be monitored while playing the sound specified at number 0 on page 0.

2-23 Status Window

The Status Window shows the messages that describe the current status.

2-24 Window Size

To change the size of the Position Window, drag the outline of the window and adjust it.

19



3. SOUND SELECTION AND PARAMETER SETTINGS

3-2
3-3 3-4
3-5
3-6

3-7

PR

3-1 Main-Parameter
In this window, you can set the main parameters for each device. A “D” shown at the left of the
parameter name indicates that it can be set for each device.

3-2 Device Select Buttons
These buttons are for selecting a device in each track. The selected device is highlighted. Click it
to selectand click it againto cancel. The number of devices can be set in the Configuration Window
(1-1.

To select all the devices at once,rclick [*] button. To cancel all the devices, click [-] button.

3-3 Direct
This shows the level of the direct sound (including the first reflection from the floor) in the selected
device. To change the value, drag the slider located below. Normally, set it to 0.0 dB.

3-4 Mute Button

To erase the direct sound (including the first reflection from the floor) of the selected device, click
this button and highlight the indication. Click it again to restore it.

3-5 Clipping Area
This shows the radius of the Clipping Area. To change the value, drag the slider below.

<What is Clipping Area?>

When the sound source is reaching closer to your ears, the theoretical sound level will be
infinitively high. It, however, isimpossible in reality, and it is set so that the volume will notincrease
from a certain distance. The value shown here is the distance. Normally, you should set all the
channels to the closest distance of all the channels. It is only the output level that is affected by
altering the value of the Clipping Area.

20



<How to use the Clipping Area>

When the sound is placed in the distance, the volume of the sound will be low. If, however, it is
placed too far, the S/N ratio will be lowered at the later mixing. If this happens, you may have to
widen the Clipping Area to suppress the volume reduction. For example, when the sound source
is placed at the position 3 meters away from your ears and set the Clipping Area to 0.24 meters,
the volume of the sound will be 1/10. To increase the volume, widen the Clipping Area. When
several sounds are placed at different positions, adjust the Clipping Area considering the distance
of each sound source.

3-6 Reverb Level
The basic Reverb Level is shown in this area. The rate of the direct and reverb sounds vary
depending on the position of the sound source. -

3-7 Output Level
This shows the output level of the selected device. Normally, set it to 0.0 dB. To change the value,
drag the slider below. :

21



4. SETTING THE OTHER PARAMETERS

4-1 Sub-Parameter

4-2 Room Size

22

This window allows you to set the depth of the Reverb and the conditions of the floor. To change
values, drag the slider located below each parameter name.

“D” or “A” shown at the left of a parameter name means as follows.

To edit the parameter that can be set for each device, select the device in the Main Parameter

Window.

D: This parameter can be set for each device.
A: This parameter is common for all the devices.

This area shows the Room Size value. Room Size represents the space where the sound will
reverberate. To change values, drag the slider below. The values for all devices will be changed.

* The Room Size is shown in the display only when the check mark is shown next to the Room
Size (9-1) in the Display Menu.

<NOTE>

The variable range of the Reverb Time will be restricted depending on the Room Size. If the Reverb
Time exceeds the range by changing the Room Size, the Reverb Time will be automatically
changed. The Room Size is the parameter that is common for all the devices, therefore, the Reverb
Time of all the devices will be changed within the range. For example, if the Room Size is 100
meters, the Reverb Time will be restricted to more than 1.0 second, and if the Room Size is 1 meter,
the Reverb Time will be restricted to less than 4.0 seconds.
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4-3 Reverb Time

4-4 Wall Color

4-5 Flavor Type

This area shows the Reverb Time. Reverb Time is the time from when a sound starts reverberating
until it stops. Adjust the time as you actually listen to the sound. Drag the slider below to change
the value of the device that includes the channel currently selected.

<NOTE>
The variable range of the Reverb Time will be restricted depending on the Room Size. If the Reverb
Time exceeds the range, the Room Size will be automatically changed.

The Room Size is the parameter that is common for all the devices, therefore, the Reverb Time of
all the devices will be changed within the range.

This controls the Wall Color. Wall Color simulates the tone change of the reverb sound reflecting
from the walls. Adjust it as you actually listen to the sound.

This area shows the Flavor Type. Drag the slider below to change the value of the device that
includes the channel currently selected.

<What is Flavor Type>

Flavor Type is the parameter that is related with the tone of reverb sound. If you input several sounds
created from the same source into several RSS-10s and mix them, reverb sounds will interfere with
each other, possibly resulting in an odd sound localization. Should this occur, try setting the Flavor
Type of each RSS-10'to a different setting. The Flavor Type alters the tone only subtly, and therefore
will have no effect in situations other than the above. .

<How to use the Flavor Type>

When you wish to add spaciousness to performances recorded in stereo using the RSS-10, connect
two RSS-10s to the right and left separately to mix the sounds. Set the Reverb to the same setting
for the right and left, but set the Flavor Type to different settings. If the Flavor Type is set to the same
value, the reverb sound will be located at the center of the speakers, and the produced sound will
not be as spacious as you expect.

4 )
L Flavor Type 0
»> RSS-10
R
Stereo Flavor Type 1 Mixer
R A L
 » ——1 RSS-10
R
N _J
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If you wish to increase the density of the reverb sound, connect several RSS-10s as shown below.
Set the Reverb to the same value, but set the Flavor Type to different values. If the Flavor Type is
setto the same value, no effect will be created (the density of the reverb sound will not be increased).

4 )
Flavor Type 0
—®  —] RSS-10
R
Flavor Type 1 )
1 o A | Rsst0 = Mixer
Flavor Type 2 L
o A _| Rss-10
: R
\— J

4-6 Floor Distance
This indicates the distance from your head to the floor. By changing the height of the head position,
the direction of the reflection from the floor will change.

4-7 Floor Color
This adjusts the Floor Color. Floor Color simulates the tone change of the sound that reflects from
the floor.

4-8 Reflect
This adjusts the portion of the sound reflecting from the floor. If you wish the sound to completely
reflect from the floor, set the value to 0.0 dB.

24



5. FILE MENU

The File Menu contains various commands such as loading, creating and saving files, or setting the environment of RSS-

FX.

5-1 New

5-2 Open

5-3 Close

5-4 Save

5-5 Save as

5-1 — New Ctrl+N
5-2 — Qpen... Ctrl+0
5-3 Close Ctrl+Ww
5-4 — Save Ctrl+S

§-5 —— Save as...

5-6 —r Open Movement Loader...
5-7 —+ Configuration...
5-8 =1 MIDI Interface 4

5-9 — Quit , Ctrl+@

Selecting this will open a new file that has been set to use only one RSS-10. If you wish to change
the number of RSS-10s or set modes, open the Configuration Window (1-1) by selecting
Configuration (5-7).

To opeh an existing RSS-FX file, select [Open). This will open a dialog box that allows you to select
a file. Select the file you want.

* You cannot open more than one file at the same time.

To close afile, select [Close]. If you have changed the contents of the file, a dialog box will appear
and ask you if you wish to save the changes you have made. Click the button you want.

To save the file, select [Save]. If the file has been saved previously, the contents of the file will be
automatically updated. If you wish to save a new file, specify the location to save the new file and
the file name in the dialog box, then save it.

If you wish to save a new file in a different folder or save the file with a different file name, select
[Save as]. A dialog box will appear, so you can specify the location to save the file and the file name,
then save it.

25
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5-6 Open Movement Loader

26

Use this window for loading the Movement stored in an external file into the file currently open.

5-6-2 5-6-3

5-6-1
5-6-4

5-6-5

5-6-6

5-6-7

§5-6-1 Movement Loader
Use this window for loading a Movement from an external file to the file currently open.

5-6-2 File

Use this window to re-open the external file.

5-6-3 Exit

Click this to exit the Movement Loader.

5-6-4 Source Page
Click this for changing pages of the Movement in an external file. Click the right half of the button
to advance a page, and click the left half of the button to back up.



5-6-5 Source Movement

This indicates the Movement in the source (external file} location. If you wish to copy the Movement
stored in an external file, drag the Movement you wish to copy to the Destination Movement (5-
6-7). If any data exists at the Destination, the following Alert Window will open, asking you if you
wish to overwrite it. To overwrite it, click OK.

5-6-6 Destination Page
This changes pages of the Movement in the destination location. To turn to the next page, click the
right half of the button. To back up, click the left half of the button.

5-6-7 Destination Movement

This shows the Movement of the destination location.

§-7 Configuration

To set the environment of RSS-FX, select “Configuration” to open the Configuration Window (1-
1). For details, see Configuration Window (1-1).

5-8 MIDI Interface

5-9 Quit
Use this command to exit the application. If the data has been edited, the dialog box will appear,
asking you if you wish to save the new data or not.

27



EDIT MENU

Em___ EE_

6-1—— Undo Ctrl+Z 6-5— Undo 6-8 — Undo

- 6-2 —— Cut Events 6-6 — Copy Notes 6-9 —+} Cut Phrases
6-3 Copy Events 6-7 — Paste Notes 6-10— Copy Phrases
6-4 — Paste Events 6-11 —— Paste Phrases

6-1 Undo, Redo
Select this to cancel the editing operation you have just made on the Movement (Undo). Select it
again right after the cancellation, and the result of the operation will be restored (Redo).

6-2 Cut Events

This cuts the Events in the currently selected Movement, then copies them to the Paste Buffer.

6-3 Copy Events

This copies the Events in the currently selected Movement to the Paste Buffer.

6-4 Paste Events
Inserts the Events stored in the Paste Buffer right after the current position. The Events selected before
the Paste Events is carried out will be erased.

6-5 Undo, Redo
Select this to cancel the editing operation you have just made on the Source Information (Undo).
Select it again right after the cancellation, and the result of the operation will be restored (Redo).

6-6 Copy Notes
This copies the Note Messages in the MIDI-Note Window in the Paste Buffer.

6-7 Paste Notes
This pastes the MIDI Note Messages stored in the Paste Buffer.

6-8 Undo, Redo

Select this to cancel the editing operation you have just made in the Sequence Window (Undo).
Select it again right after the cancellation, and the result of the operation will be restored (Redo).

6-9 Cut Phrases

This cuts the Phrase selected in the Sequence Window and copies it to the Paste Buffer.

6-10 Copy Phrases

This copies.the Phrase selected in the Sequence Window to the Paste Buffer.

6-11 Paste Phrases

This pastes the Phrase stored in the Paste Buffer to the current position.
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7. SELECT MENU

7-1

7-2

7-3

7-5

7-7

7-8

7-1 — All Event 7-4 — All Phrase

7-2 — None of Events 7-5 —4 All Previous Phrase

7-3 Inverse Selection 7-6 All Later Phrase
7-7 —+ None of Phrases
7-8 — Inverse Selection

All Events
Select this to select all the Events in the Movement.
None of Events
Select this to cancel the selection of all the Events in the Movement.
Inverse Selection
The selected Events will be unselected and the unselected Events will be selected.
All Phrases
This selects all the Phrases in the Sequence.
All Previous Phrases

This selects all the Phrases prior to the current position in the Sequence.

All Later Phrases
This selects all the Phrases posterior to the current position.

None of Phrases
This cancels all the Phrase selections in the Sequence.

Inverse Selection
The selected Phrases will be unselected and the unselected Phrases will be selected.
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8. MODIFY MENU

Modif)«"
8-1 Smooth Movement (1)
8-2 —+ Smooth Movement (3)
8-3 — Smooth Movement (3)

8-1 Smooth Movement (1)
Select this to make a smoother slope for the movement in the Event of the currently selected
Movement. This will cause the smallest effect of the three types 1, 3 and 5.

8-2 Smooth Movement (3)
Select this to make a smoother slope for the movement in the Event of the currently selected
Movement, This will cause an effect more intense than type 1.

8-3 Smooth Movement (5)
Select this to make a smoother slope for the movement in the Event of the currently selected
Movement. This will cause the most prominent effect of the three types, 1, 3 and 5.
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9. DISPLAY MENU

This menu allows you to set the parameters related with the display.

9-1 1t Room Size

9-2 —— Position
9-3 Time at Current Position
9-4 — |ength of Selected Events

9-5 — Redraw Screens

- 9-1 Room Size °
If you wish to have the frame of the Room Size displayed in the Movement Window (2-1), select
[Room Size] and it will become checked. if you wish to cancel it, select [Room Size] again and erase
- the check mark.

9-2 Position
If this item is checked, the Status Window will show the coordinates of the current position.

9-3 Time at Current Position
If this item is checked, the Status Window will show the time from the top of the Movement to the
current position.

9-4 Lengih of Selected Events
If this item is checked, the Status Window will show the total length (time) of the Events in the
currently selected Movement.

9-5 Redraw Screens
Select this to redraw the display in the Movement Window (2-1).
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10. STATUS MENU

10-1 — Update Stafus

10-2 — Bypass OFF

10-1 Update Status
To transmit the settings of RSS-FX to each connected RSS-10, select [Update Status]. This can be
effectively used when the setting on RSS-FX happens to differ from the settings on each RSS-10.

10-2 Bypass OFF
Select this to turn off the Bypass on the RSS-10. =
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11. WINDOW MENU

RSS-FX’s Window Menu provides Main Parameter Window (3-1), Sub Parameter Window (4-1), MIDI Note Window (13-
1), Sequence Window (12-1), and Phrase Information (14-1). In the Window Menu, you can open or activate the specified
window.

windom
11-1 —— Saved Arrangement

11-2 =t Main—Param Window
11-3 — Sub-Param Window
11-4 —+ MIDI-Note Window
11-5 == Seguence Window
. 11-6 — Phrasse Information Window

11-1 Saved Arrangement
Use this command to retrieve the same position and size of the windows as you previously saved
the file. ‘

11-2 Main-Parameter Window
To open the Main Parameter Window, select [Main-Parameter Window]. If the Main Parameter
Window is already open, selecting this will locate the Main Parameter Window to the top position
in the screen.

11-3 Sub-Parameter Window ‘
To open the Sub Parameter Window, select [Sub-Parameter Window]. If the Sub Parameter
Window is already open, selecting this will locate the Sub Parameter Window to the top position
in the screen.

11-4 MIDI-Note Window
To open the MIDI Note Window, select [MIDI-Note Window]. If the MIDI Note Window is already
open, selecting this will locate the MIDI Note Window to the top position in the screen.

11-5 Sequence Window
To open the Sequence Window, select [Sequence Window]. If the Sequence Window is already
open, selecting this will locate the Sequence Window to the top position in the screen.

11-6 Phrase Information Window
To open the Phrase Information window, select [Phrase Information Window].
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12. SEQUENCE WINDOW

12-1 12-7 12-9 12-312-4

Sequerge

12-8 -
12-6

12-5
12-2

12-1 Sequence Window :
This window allows you to attach the created phrase on the time line for synchronization and play
it. A Phrase is made with Movement and Note Information.

12-2 Temporary Phrase
This is a phrase for temporary use. Catch the rectangle with the mouse, and drag to the track to attach
the Phrase to the track. If any Phrase exists in the destination track, the display shows the Alert
Window as below. If you wish to write the new phrase, erasing the old one, click OK.

12-3 Temporary Play Button
Use this button to play the Temporary Phrase. When you click this button, the Note On Message
primarily set will be transmitted. Then, the set Movement is played, and finally the Note Off
Massage is transmitted. You can play/stop the phrase by pressing the Space Bar on the keyboard.
The data is transmitted to the device selected with the Device ID (12-5).

12-4 Stop Button
Use this button to stop playing the Temporary Phrase.

12-5 Device ID
This shows the Device ID on which the Temporary Phrase data is transmitted. When this is clicked,
you can select the device you like from the Device ID’s set in the Configuration Window.
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12-6 Select Movement (Page)

This selects the page of the Movement. There are 5 pages from 0 to 4. Clicking the right half of the
button will advance a page, and clicking the left half of the button will back up a page.

12-7 Select Movement (Numbers)

These buttons select the number of the Movement set to the Temporary Phrase. There are 10
numbers from 0 to 9, and therefore 50 data will be made with 5 pages. The data is created in “Move
ment Window” (2-1).

12-8 Select Notes (Page)

This button selects the page of the Note Information. There are 5 pages from 0-4. Clicking the right
half of the button will advance a page, and clicking the left half of the button will back up a page.

12-9 Select Notes (Numbers)

These buttons select the Note Messages set in the Temporary Phrase. There are 10 numbers from
0-9, and therefore 50 data will be made with 5 pages. The data is created in “MIDI Note Window”
(13-1).
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12-25

12-24

12-22

- 12-23
1211 12-21

1213 | 12-15 12-10 12-12
12-14 12-19 12-16 :
: 12-17
12-18

12-10 Track :
You can bring and place a Phrase from the Temporary Track to each Track where the Phrase is
attached and played. It is also possible to catch the phrase and drag it by mouse operation. If you
drag the phrase while holding the [SHIFT] key down, the phrase can be shifted by the unit as shown
below depending on the indication range.

5 min ) 1 min
2 min 30 sec
1 min 10 sec
30 sec 5 sec

15 sec 1 sec

12-11 Track Button
This shows the Device ID of each track. If you click and erase the number, the track will not be
played.

12-12 Zoom In
12-13 Zoom Out

You can change the magnification of the indication on the track by clicking this button. It can be
changed in the indication range of 15 sec, 30 sec, 1 min. 2 min. and 5 min. The variable range is
shown in (12-4).

12-14 Display Point

This shows the Track data that is displayed in the screen. You cannot click and move it.

12-15 Current Position
This shows the current position.

12-16 Play Button

By clicking this button, you can start playing the sequence. When synchronizing to an external
device, the sequence will not be played unless it receives the time codes.
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12-17 Stop Button
To stop playing, click this button. To resume playing, click the Play Button again.

12-18 FF Buton (Fast Forward Button)

Click this button, and the Current Time will be shifted to the later time.

12-19 Rewind Button

Click this button, and the Current Time will be shifted to the earlier time.

12-20 Reset Button -
Click this button, and the Current Time will be reset to “01:00: 00 : 000" (one hour). When the Offset
Time Switch (12-27) is set to “On,” Offset Time (12-26) will be added.

12-21 Current Time
This area shows the currenttime. By dragging up or down with the mouse in the Hour, Minute and
Second frame (ms), you can alter the current time.

12-22 Spare Register
This area shows the time of the Spare Register (the time in memory where the time is temporarily
stored). By dragging the mouse up or down in the Hour, Minute and Second frame (ms), you can
alter the time. Use the Spare Register for entering the time, writing a temporary memo, finely
adjusting the time, etc.

12-23 Store Time
The Current Time will be copied to the Spare Register by clicking this button.

12-24 Jump

Click this button to jump to the time written in the Spare Register.

12-25 Marker
These 8 buttons are Marker Buttons. By clicking one of these buttons, you can jump to the place
which is written in the register of the corresponding number. If you click the button while holding
[SHIFT] key down, the current time will be written in the Register of the relevant number. If you
click the button while holding [OPTION] key down, the time in the Spare Register (12-22) will be
written in the register of the relevant number.
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12-29 12-28 12-27

Sequence ]

12-26

12-26 Offset Time
This area shows the Offset Time. By dragging the mouse up or down in the Hour, Minute and Second
frame (ms), you can alter the time.

12-27 Offset Time SW (Offset Time Switch)
You can turn on or off the Offset Time by clicking this button. When it is ON, the time indication
(12-21, 12-22) will be the time with Offset Time added.

12-28 Frame Mode
By clicking this button, you can set the Frame Mode of the Time Code. The time indication (12-21,
12-22, 12-26) is shown in the mode set here. However, the resolution of the time for attaching
phrases is fixed to 50 ms.

12-29 Sync

: By clicking this button, you can change the standard of the playback time to the Internal or External.
When External Sync is selected, be sure to use the MIDI Interface that can receive the time code
and convert it to MTC.

MOTU’s MIDI TIMEPIECE H
MOTU’s MIDI EXPRESS Mac
OPCODE’s Studio5
OPCODE’s Studio4
OPCODE’s Studio3
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13. MIDI NOTE WINDQW

RS

13-1 13-3 13-5 13-6 13-8 13-9 13-10 13-11
/
MIDINoj [

13-2
13-4
13-7

il A ALl )

13-12 13-13 13-14 13-15

13-1 MIDI-Note Window
This window allows you to set the Note Messages that should be combined with the Phrase. You
can also set the Program Change Message as well as the Note Messages. Set these messages if you
wish to play the phrase using a MIDI sound module. The phrase can be played in the Sequence
Window (12-1). :

13-2 Send notes
Click this button (it will. become checked) to transmit Note Messages. Note Messages are
transmitted when phrases are played.

13-3 MIDI Channel
This area shows the selected MIDI channel. You can change channel numbers by dragging the
mouse up and down while holding its button down. If the number happens to change too
drastically, setthe channel by dragging the mouse while holding the [SHIFT] key down. If you select
"--" as the setting here, the midi channel selected in the Configuration window will be used.

13-4 Send Program Change
Click this button (it will become checked) to send the Program Change messages. Program Change
messages are transmitted when the phrases are played.

13-5 Program Change Number
This area shows the selected Program Change Number. You can change numbers by dragging the
mouse up and down while holding its button down. If the number happens to change too
drastically, set the number by dragging the mouse while holding the [SHIFT] key down.

13-6 Display Format of Program Change
This allows you to select whether to display the Program Change Number in the way of [1-128] or
[A11-B88).

13-7 Message Window

It shows the relevant messages for some operations you have taken.
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13-8 Velocity

This area shows the Velocity of the Note Message to be transmitted. You can change values by
dragging the mouse up or down while holding its button down. If the number happens to change
too drastically, set the number by dragging the mouse while holding the [SHIFT] key down.

13-9 Select Notes (Page)
This button selects the page of the Note Message. There are 5 pages from 0-4. Clicking the right half
of this button advances a page, while clicking the left half backs up a page.

13-10 Select Notes (Number) ,
This selects the Number of the Note Message. There are ten numbers from 0-9 and altogether 50
data can be made with 5 pages.

13-11 Link Button
If you change the settings in the window while this button is setto ON, the Temporary Phrase in
the Sequence Window will be similarly changed.

13-12 Keyboard
Click the key that corresponds to the Note Number you wish to play. Each time you click the key,
the key will be selected and canceled alternately. Up to 8 keys can be set at the same time. If you
click the key while holding the [SHIFT} key down, you can monitor only the key you have clicked.
If you wish to monitor the sound without the RSS effect, click the key while holding the [OPTION]
key down.

13-13 Sound Button (Dry) :
By clicking this button, you can play the selected key without the RSS effect.

13-14 Sound Button ,
By clicking this button, you can play the selected key with the RSS effect.

13-15 Clear Bufton

By clicking this button, you can erase all the notes set on the Keyboard (13-12).
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14. PHRASE INFORMATION WINDOW

14-1

Phrase Information

14-3
14-4
14-5
14-6

14-2

14-1 Phrase Information Window
This window allows you to check the setting of a certain phrase. Select a Track you wish to check,
and the screen shows the relevant setting. The setting shown in the window, however, cannot be
edited. You can open this window also by double-clicking the phrase on the track.

14-2 Movement
This shows the Movement setin the Phrase you specified. It shows the movement curve of the sound
observed from the top.

14-3 Movement Page Number
This shows the page and number of the Movement you have specified.

14-4 MIDI Note

This shows the page and number of the MIDI Note message set in the phrase you have specified.

14-5 Start Time
This shows the time to start playing the specified phrase.

14-6 Length
This shows the length of the specified phrase.
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